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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to 
prevent damage to property. The notices referring to your personal safety are highlighted in the manual 
by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These 
notices shown below are graded according to the degree of danger. 

 

DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of 
danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a 
warning relating to property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for 
the specific task in accordance with the relevant documentation, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are 
capable of identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens Process Analytics products 
Note the following: 

 

WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks  
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the 
rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and 
software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. 
However, the information in this publication is reviewed regularly and any necessary corrections are 
included in subsequent editions. 

 
 
 
 

Siemens AG 
Industry Sector 
Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

Order number: 2000684-001 
Ⓟ 04/2015 Subject to change 

Copyright © 2015Siemens AG. 
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Preface 
If you are unfamiliar with any of the terms or concepts used in this document please refer to the Glossary section 
located at the end of this document. If you wish to obtain more information on any of the terms or concepts 
presented here please refer to the section titled: Additional Information Resources. 

 
 
 
 

Trademarks 
The OPC logo is a registered trademark of the OPC Foundation. 

 
 

DirectX, Microsoft, Visual Basic, and Windows are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 
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1. Introduction 
Maxum OPC Server is a software application that provides a standard interface to Siemens Process Gas 
Chromatographs. The server acquires real-time analysis results and presents the data through an OPC DA 
interface.  Any OPC compliant client may access the data remotely using standard OPC protocols.  A single 
OPC Server can provide data from multiple Siemens GCs to multiple client applications or a single client may 
access data from multiple OPC Servers. Maxum OPC Server is the ideal solution for sharing process analytical 
information with Distributed Control Systems, Statistical Quality Control programs, Data Historians or any custom 
application supporting an OPC interface 

Maxum OPC Server provides the following features: 

• OPC DA 2.04 compliant 
• Runs as a Windows® Service 
• Tag browsing using OPC Foundation List Server (OPCEnum.exe) 
• Supports server self-registration 
• Support for both the OPC Custom and Automation Interface (Visual Basic®, VBA) 
• Supports both local and network data access 
• Uses free threading model for efficient COM/DCOM communications 
• Supports asynchronous and synchronous communications 
• Supports network communication over Ethernet, Advance Datanet, and Advance DataHiway*. 

 

1.1. System Requirements 
Platform requirements : 

 

Component Minimum Recommended 
 

CPU 

1.4 GHz or faster 
32-bit (x86) or 64-bit (x64) processor for single core 
1.3 GHz or faster 
32-bit (x86) or 64-bit (x64) processor for multi-core 

 
3.1 GHz (64-bit processor) or faster 
multi-core 

Memory (RAM) 4 GB 16 GB 
Hard Drive 50 GB 100 GB 

Display Super VGA (800 x 600) or higher-resolution monitor Microsoft® DirectX® 9 graphics 
device with WDDM driver 

 
 

1.1.1. Supported OS 
 

Microsoft Windows 7 SP1 
Microsoft Windows 8 SP3.1 
Microsoft Windows 8.1 SP1 
Microsoft Server 2008 SP1 
Microsoft Server 2008 R2 SP1 
Microsoft Server 2012  

Microsoft Server 2012 R2  

 
While Maxum OPC Server may work on platforms not meeting the minimum specifications, operational reliability 
and efficiency will be diminished. 
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1.1.2. Product Interface Requirements 
 

Product Description 
Maxum 
Maxum Edition II 

Can connect to the Maxum OPC Server directly through an Ethernet or DataNet 
network 

*Advance Optichrom Requires an (ODS) Optichrom Data Server. The ODS consists of a NAU 
(Network Access Unit) and either an Advance Ethernet Gateway or an Advance 
DataNet Gateway. The Optichrom analyzers communicate to the ODS and the 
ODS communicates with OPC Server. 

MicroSam Can connect to the Maxum OPC Server directly through an Ethernet or DataNet 
network 
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2. Overview 

2.1. OPC 
OPC, now known as Open Platform Communications, is a series of standards designed to bridge Windows 
based applications and process control hardware and software applications. It is an open standard that permits 
a consistent method of accessing field data from industrial devices. OPC DA, or OPC Data Access was the first 
standard created by the OPC Foundation. 

OPC DA is based on Windows COM (Common Object Model). COM is a binary standard that specifies how 
objects interact with each other. A COM object is accessed exclusively through one or more sets of interfaces. 
An interface is a set of functions or methods. The COM standard not only specifies the binary object standard, it 
also defines a series of standard interfaces that provide common functionality. The OPC-DA specification defines 
several COM objects and their associated interfaces. These objects and interfaces provide a standard for real- 
time information exchange between software applications and process hardware. 

DCOM or Distributed Common Object Model extends COM communication to remote COM objects running on 
networked machines. 

 

2.2. OPC Server Service 
Maxum OPC Server is a COM object server that runs as a Windows 32-bit service (MaxumOPCServer). 
Windows services are controlled by the Service Control Manager (SCM). The SCM is the central utility provided 
by Windows to administer services. SCM is used to start, stop, pause, resume, and configure a service. A 
Windows service exporting a COM component must be recognized by the operating system as a COM server 
and as a running service. Therefore, it must be registered directly in the registry as a COM server and in the 
services database as a service. LocalService is a registry key that merges two fundamental constructs of the 
Microsoft Win32® environment. It binds a Component Object Model (COM) component to a service combining 
the benefits of both technologies. The resulting object is available to COM clients and service controllers. 
Services registered with LocalService are not automatically stopped between logon sessions. Like other 
services, LocalService continues to execute when a user session concludes 

MOS is automatically registered and added to the services database during installation under the name 
MaxumOPCServer. To view the MOS service properties select Start, then type “service.msc” in the Search 
programs and files box. Once the Services console is displayed, scroll down to MaxumOPCServer. 

 
Right click on MaxumOPCServer and select Properties from the pop-up menu to display or change OPC 
Server properties. Under the General tab there are buttons to Start, Stop, Pause, or Resume the service. The 
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service start mode can be set in the Startup type: drop down box. Select Automatic (Delayed Start), 
Automatic, Manual, or Disabled. 

 

Automatic – starts the service immediately on 
system start-up (Power-up). This is the 
recommended setting for MOS. 
Automatic (Delayed Start) – starts the service 
shortly after all other services designated as 
Automatic have been started. Use this setting for 
the less critical services. This setting ensures that 
the critical services get their resources early, become 
available sooner. The default delay is 120 seconds. 
Manual – The service can only be started by the 
currently logged-on user clicking the Start button. 
Disabled – disables the service from running. 

 

Within a service, you assign a COM component a 
user or system security context. MaxumOPCServer 
service is typically configured to run in the security 
context of the LocalSystem account.  Select the 
Log On Tab. 

 
The Local System account is a predefined local 
account used by the Service Control Manager. This 
account has extensive privileges on the local 
computer, and acts as the computer on the network. 
A service that runs in the context of the 
LocalSystem account inherits the security context of 
the SCM. (Service Control Manager). 

 
IMPORTANT: A user must have Administrator privileges to fully access a service running under the 

LocalSystem account. However, it is possible for a standard User account to run 
MaxumOPCServer with only Start/Stop user permissions. See the section titled 
“Starting the MOS service without administrator permissions.” 
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2.3. OPC Server User Interface 
Windows Services are designed to run unattended without a user interface or a logged on user. 
MaxumOPCServer service runs unattended without a user interface or a logged-on user once the Tag database 
is created. A separate Windows application, Maxum OPC Client (MOC), is used to create, delete, modify, 
monitor, and save the Tag database.  MOC provides a user-friendly, graphical user interface (GUI) that allows 
the Interactive user (the logged on user) to communicate directly with the MOS service. When the logged-on 
user starts the MOC application, it tests if the MOS service is already running, then attaches to the OPC server. 
If the MOS service is not running, the Client application uses the SCM to start the MOC service and then attach 
to the server. The OPC Client application can be stopped at any time without affecting the operation of the MOS 
service. The MOS service will continue to run even if the user logs off the system. 

 
2.4. Starting MOS without Administrator Privileges 

 
To overcome the limitation of requiring every user who needs access to MOS to have Administrator privileges, a 
third application, Launch.exe is provided. Launch uses the Service Control Manager (services.msc) to signal 
the MOS service to start MaxumOPCClient from the security context of the MOS service. This means that the 
interactive user does not need to be a member of the Administrators account to use MaxumOPCClient. The 
interactive user needs only start/stop access permissions to edit and monitor the MOS service with 
MaxumOPCClient. 

One method to assign a standard User account the ability to Start/Stop MaxumOPCServer is to use a Security 
Template. Security Templates can be used to modify the MOS service’s ACL (Access Control List) to allow 
start/stop permissions only. You must have Administrator privileges to perform the following steps: 

1. Create a new custom security template using Microsoft Management Console (mmc) with Security 
Templates and Security Configuration and Analysis snap-ins. 
a. Go to Start > Run, type: mmc, press enter 

Add the two snap-ins from the main menu: 
b. Select File > Add/Remove Snap-ins … 
From the Available Snap-ins drop down box: 

c. Select Security templates then click on Add. 
d. Select Security Configuration then Add. 
e. Click on OK. 

 

2. From the Console Tree (left window panel) expand the Security Templates and right click on 
[DriveLetter]:\Windows\security\templates. 
a. Select New Template 
b. Enter a name for the new template in Template Name 
c. Click on OK 

 

3. From the Console list (middle window panel): 
a. Double click on the newly created template name. Or, from the Console Tree (left window panel) 

expand the Security Templates then expand the [DriveLetter]:\Windows\security\templates. 
b. Select the newly created template. 
c. Select System Services. 
d. From the Console list scroll down to MaxumOPCServer. 
e. Double click on MaxumOPCServer to bring up the Service Properties dialog box. 
f. Check the Define this policy setting in the template checkbox. 
g. Click on the Edit Security button. 
h. Add the account to delegate permission for. Using the INTERACTIVE account is suggested. 
i. Check the start, stop and pause checkbox under permissions. 
j. Click on OK to exit Security for MaxumOPCServer dialog. 
k. Click on OK to exit MaxumOPCServer Properties dialog. 
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4. Save the new template. 
a. Right click on the new template name in the Console Tree (left pane). 
b. Select Save from the pop-up menu. 

 

5. From the Console Tree (left window panel): 
a. Right click on Security Configuration and Analysis. 
b. From the pop-up menu select Open Database. 
c. Under File Name enter a unique name for the security database and select Open. 
d. Select the Security template name entered in step 2 above. 
e. Click on Open to import the new template. 

 

6. From the Console Tree (left window panel): 
a. Right click on Security Configuration and Analysis. 
b. From the pop-up menu select ConFigure Computer Now. 

 

7. If no errors are displayed this procedure is complete. To verify: 
a. Log Off the machine, then Log On using a non-administrator account. 

Go to Start > Run, type service.msc, press enter. 
b. Scroll down to the MaxumOPCServer service. 
c. Double click MaxumOPCServer to bring up the Properties dialog. 
d. Verify that the Start button is not grayed out and the MaxumOPCServer service can now be Started 

and Stopped. 
e. Verify that the Launch.exe program works correctly. 
f. Go to Start > Run, browse to: C:\Program Files(x86)\Siemens Industry\Maxum OPC Server. 
g. Select Launch.exe. 

Maxum OPC Client (MOC) should now be running. 

MOC uses a secure shared memory region to communicate directly with MOS. Connecting and dis-connecting 
from the MOS service will not affect the service’s operation. 

IMPORTANT: When using the MOC to add, delete, or edit the OPC configuration file (*.cfg) you must save the 
configuration file prior to closing MOC or all changes will be lost once the MOS service is Stopped. 
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3. Getting Started 
This section describes the necessary steps to install, configure, and run OPC Server. 

IMPORTANT: Maxum OPC Server is compatible with Maxum database version 4.0 (or greater). 
Please upgrade any analyzer running an earlier version before starting the server 
configuration procedure. Optichrom analyzers communicate through an intermediary 
device called an Optichrom Data Server. The Optichrom Data Server provides the 
necessary database conversions between the two systems. One of the many 
enhancements provided in version 4.0 is the OPC table. The OPC Table was added 
to facilitate data exchange between Maxum analytical devices and OPC Server. The 
OPC Table must be initialized and populated before a device or analyzer is added to 
OPC Server. 

Complete the following steps in order: 

Step 1 – Install OPC Server software. (3.1) 

Step 2 – Configure analyzer to communicate with OPC Server. (3.2) 

Step 3 - Create the OPC Tag database. (3.3 Using Maxum OPC Client And Server) 
 

3.1. Step 1 - Install Maxum OPC Server software 
IMPORTANT: The installer software requires that the logged On user have administrator permissions. 

To install the Maxum OPC Server software follow these steps: 

a. Insert the Maxum Workstation DVD into the 
DVD player. If the AutoPlay option is enabled 
Windows will automatically start the installation 
program. If the AutoPlay option is disabled use 
Windows Explorer to browse to the DVD and 
double-click on the “setup.exe” file. Click on the 
Install Maxum OPC button. 
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b. The next screen is the License Agreement 
screen. Please read the License Agreement 
carefully. If you agree to all the terms and 
conditions select: “I accept the terms of the 
agreement” radio button. Then click on the 
Next button. 

 
c. Enter your User Name, Organization, and 
License key on the Customer Information 
screen. Then click on the Next button. 

 
d. Click on the Next button on the Destination 
Folder screen to accept the default installation 
path or click the Change… button to change 
the destination path to an alternate location and 
then click the Next button. 
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e. Click on the Install button to begin the 
installation process. 

 
f. The installation program will install the OPC 
Server software. 

 
g. Once the OPC Server software is 
successfully installed select the Finish button to 
complete the installation process. 

 
 

This completes the installation procedure. The OPC Server has been installed and registered as both a COM 
server and a Windows service: MaxumOPCServer. The required OPC Foundation support programs are 
automatically registered and no additional installation steps are required. 
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3.2. Step 2 - Configure analyzer to use OPC 
3.2.1. How to configure a Maxum analyzer to communicate with 

OPC Server 
 

 

b. Set the Application\Stream\Result transmit order. 

From the GCP Analyzer View select Application View on the View Selector bar. From the Application View 
select Results then select the Result Configuration tab. Set the order results will be transmitted to OPC Server 
for each Application and stream. Results may be sent in any order. The Transmit Value column displays the 
Stream sequence order. The individual Result sequence order can be set on the Properties panel next to 
Transmit Value. To set the entire sequence for all streams select the Edit Order Values... button. Select the 
Stream(s) and Results to order then check the TransmitVal checkbox, select Apply then OK buttons. This sets 
the trtval attribute in the result table for each selected result. Trtval values must be sequential starting with ‘1’. 
Out of sequence values or results with a trtval equal to ‘0’ will not be transmitted. Repeat this step for each 
application/stream. 

a. Enable OPC functionality by checking 
the Enable OPC check box. 

 
Using Siemens Gas Chromatograph 
Portal Network View (GCP-NV) select the 
analyzer to be configured then double- 
click to connect and display the GCP 
Analyzer View (GCP-AV). 

 
From Analyzer View select Analyzer on 
the View Selector bar. On the Navigation 
panel under Analyzer View select 
Network -> OPC . On the OPC 
Configuration tab check the Enable OPC 
check box. This checks the OPCflag 
attribute in the system_control table. 



Maxum OPC Server 
User Manual, 9/2014, v3.00, 2000684-001 15 

 

 

 

 
 

c. Set the stream(s) Auto Transmit Result check box to insure the results are sent at the end of cycle. 

From the Application View on the Navigation panel select Sequences. Select the Stream/Method Settings tab. 
From the Properties panel set the Auto Transmit Result check box for each stream. Repeat this step for each 
application that will be sending Results to OPC Server. This procedure sets the autotrt attribute in the 
stream_method table. 

When using Optichrom analyzers with OPC Server define the preferred Optichrom communication protocol. 
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d. Optichrom analyzers support several different communication protocols. HCI-H (Modbus), HCI-CO1, HCI- 
C04, and HCI-A (ASCII). OPC Server requires that the data be sent in Maxum Analyzer format. The Maxum 
analyzer database provides routines to convert Optichrom protocols to Maxum format. Use GCP Analyzer View 
to specify the Optichrom protocol to be converted. From Analyzer View select Analyzer on the View Selector 
bar. On the Navigation panel under Analyzer View select Network. On the Advance Data Hiway tab select the 
Format drop down list box and select the desired Advance Data Hiway protocol. This sets the adh_trtformat 
attribute equal to the desired host computer format: 0=HCI-H, 1 = HCI-C01, 2 = HCI-C04, 3 = HCI-A in the 
System_control table. 

Optichrom analyzers use Advance Data Hiway as the physical medium for all communication. Maxum analyzers 
use Ethernet. This requires the use of a media convertor to convert ADH to Ethernet. The Advance Network 
Gateway card (ANG) provides this conversion. Typically a Network Access Unit (NAU) is used as an Optichrom 
Data Server (ODS) to collect, convert, and transmit the Optichrom data to OPC Server. The Optichrom Data 
Server consists of and NAU (Network Access Unit) with an ANG (Advance Network Gateway) card. The NAU 
must be configured to use an OPC Server. 

The OPC table must be initialized with each streams results before you configure OPC Server. OPC table 
entries are automatically created at the end of each analysis cycle. Run at least one analysis cycle on each 
stream prior to configuring OPC Server. 

 
3.2.2. COM Server Registration 

Maxum OPC Server is automatically installed and registered during the installation process. You can use the 
windows program regedit to check the registry entries. OPC Server puts two entries under the 
HKEY_CLASSES_ROOT key. One is Siemens.MaxumOPCServer which contains the version-independent 
program ID (CLSID) and, one titled Siemens.MaxumOPCServer.1 that contains the version-specific program 
ID(CLSID). COM/DCOM use the CLSID to determine the path to the Maxum OPC Server executable for remote 
launch capability. 
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3.2.3. Standard OPC Proxy/Stubs 
In compliance with OPC standards, the Maxum OPC Server installs and registers the following files in the 
WINDOWS/ SYSTEM32 directory on 32-bit Windows or in WINDOWS/sysWOW64 on 64-bit Windows. 

• The official OPC proxy/stub DLL’s, “OPCCOMN_PS.DLL and “OPCPROXY.DLL”. 
• The official OPC List Server (Browser) “OPCENUM.EXE”. 
• The Automation Component “OPCDAAUTO.DLL” wrapper which enables developers to access OPC 

data from client applications developed using Automation tools such as Visual Basic, VBA, and VB 
Script. 

The version information contain in these files is used to avoid overwriting newer files with outdated ones. 
 

3.2.4. OPC Foundation Supplied Programs: 
 

Filename Description 
OPCCOMN_PS.DLL Proxy library for OPC Common interface 
OPCPROXY.DLL Proxy library for OPC Custom interface 
OPCENUM.EXE OPC List server 
OPCDAAUTO.DLL OPC-DA automation library 

 
3.2.5. Maxum OPC Server Files 

The following files are installed during the installation procedure: 
 

Filename Description 
MAXUMOPCSERVER.EXE OPC Server service executable 
MAXUMOPCCLIENT.EXE OPC Server user interface application executable 
POLYHEDRA.DLL Maxum database communication dll 
OPCCLIENT.EXE OPC test client 

 
 

3.2.6. Default Directory Structure 
The MOS installation program creates the following default directory structure: 

\Program Files (x86) 
\Siemens Industry 

\System 
\Client 
\Documents 

 

The following files are loaded under the specified directory. 

\Program Files 
\Siemens Applied Automation 

MaxumOPCServer.exe - main program executable 
DbPolyhedra.dll - support dll 
SwKey.dll - support dll 
MaxumOPCServer.hlp - Windows Help file 
MaxumOPCServer.cnt - Windows Help support 

\System 
OPCerror.log - The OPC Server log file is created the first time 

program is run. 
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\Client 
AutomationClientEx.xls - Example Excel-VBA automation client program 
OPC Client.exe - FactorySoft OPC Client test program 

\Documents 
MaxumOPCServerManual.Doc - This manual 
OPCda20_auto.doc - Data Access Automation Interface Standard 

provided by the OPC Foundation 
 
 
 

3.2.7. Software Licensing 
The Maxum OPC Server utilizes a software license key to enable/disable functionality and provide warranty 
tracking information. The Installation key is a 26-digit alphanumeric number supplied with the product. The 
Installation key must be entered in the Software Registration screen during installation. Product licensing 
information is displayed in the About box. This includes the Serial Number and License type. 

NOTE: The Gas Chromatagraph Portal (GCP) provides an Update license utility that can be used to update a 
license key without having to re-run the install program. 

There are two types of license keys supported: 

• A Trial version that allows the product to run in a fully functional mode for a specific period of time, 
typically 30 days. After the time period has expired the product reverts to the Demo version. 

• The Full version that provides complete and full access on a permanent basis. 
 

There are two types of licenses available. 

• A Single user type that allows a single machine to run OPC Server on the same network. 
• A Site user type that enables multiple machines to run OPC Server on the same network. 
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3.3. Using Maxum OPC Client And Server 

3.3.1. User Interface 
Maxum OPC Client (MOC) is the Windows application used to configure Maxum OPC Server. MOC provides the 
graphical user interface (GUI) that enables the Interactive user (the logged on user) to communicate directly with 
the MOS service. 

The MOC window consists of two panels: 

• The Device Group pane: used to display the top-level device (analyzer) and associated groups. 
• The Tag View pane: used to display the tag name, value, data quality, and description. 

The Title bar located at the top of the screen displays the open MOS tag configuration file name. or untitled if no 
configuration file exists or is open. 

The Status bar located at the bottom of the screen displays the selected device logical ID, IP address, and 
device name. 

 

 
 
 

Figure 1 

Main Menu 

Device Group Pane 

Tag View Pane 

 
 

Status Bar 
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3.3.2. Main Menu 
The Main menu located towards the top of the MOS screen consists of six items: 

File, Add, Edit, View, Options, Help. 
 
 

File Menu 
 

The File menu offers the following choices: 

• New: Creates a new tag configuration *.cfg file 
• Open: Loads a configuration from a *.cfg file. See section 3.5 for a description of the configuration file 

format. The current MOS configuration is erased. 
• Save: Saves the MOS configuration to a *.cfg file. 

IMPORTANT: Save also sets the default startup file. 

• Save As: Saves the MOS configuration to a *.cfg file after prompting for a file name. 
• Export Tags: Saves the MOS device, group and tag names to a CSV file after prompting for a file name. 
• Exit: Closes the Maxum OPC Server application. 

 
 

Add Menu 
 

The Add menu offers the following choices: 

• New Device: Creates a new device group(Anlzxxx, Nauxxx). 
• New Application: Creates a new application group(Appxxx) under the selected Device group. 
• New Stream: Creates a new stream group(Strmxxx) under the selected Application group. 
• New Component: Creates a new component group(Compxxx) under the selected Stream group. 
• Component Details: Adds peak and group component details under the selected component. 

 
 

Edit Menu 
 

The Edit menu offers the following choices: 

• Delete: Deletes the selected group. 

IMPORTANT: The Delete menu item is grayed out when in the monitor mode. To delete a Device, 
Application, Stream, Component, or OPC Item de-select the Monitor command 
located under the View menu. This will enable the Delete command. 

• Properties: Displays the Device, group, and tag properties. 
 
 

View Menu 
 

• Debug: Displays the OPCError.log file in a Notepad window. 
• Status Bar: Shows or hides the Status bar. The Status bar displays the active device logical ID, IP 

address, and device name. 
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Options Menu 
 

• Short Tag Names: The Short Tag Names command is used to limit the Tag name length. This feature 
is useful for legacy OPC clients that require short tag names typically 35 characters or less. When the 
Short Tag Names feature is enabled all new tags are created with abbreviated tag name fields. Any 
existing tags are not affected by this command. If you wish to change an existing tag to a short tag 
name you must delete the old tag and re-create the tag with the Short Tag Name feature enabled. 

IMPORTANT – Do not mix Short Tag Names with Standard Tag Names. Use all Short Tag names or 
all Standard Tag names. If you are not sure, export the tag names to a file using the 
Export command and view the tag list to be certain. 

 
 

Help Menu 
 

• Help Topics…:Displays the MOS help file. Very useful information! 
• About: Displays the MOS Version number, Serial number, License type, and Support contact 

information. 
 
 

Editing 
 

There are two selections under the “Edit” item on the Main Menu. “Delete” and “Properties”. 
 
 

Deleting 
 

Devices, Applications, Streams, Components, and individual data points or Tags can be deleted from the MOS 
configuration. To delete an item or folder, select the item by right clicking the mouse on the item, in either the 
Device pane or the Tag View pane, then select “Delete” from the “Edit” menu or push the “Del” key or right click 
the mouse to display the pop-up menu and select the “Delete” item from the menu. When you delete a folder 
(Device, Application, Stream, Component) from the Device pane you automatically delete all the folders and 
items that are directly underneath the item. For example if you delete a device you delete all the Application, 
Streams, Components, and all the associated tags. If you delete a tag from the Tag View pane only the single 
item is deleted from the configuration. 

IMPORTANT –After deleting any item remember to save the Configuration file or the item will return the 
next time the MOS is re-started. 

 
 

Properties 
 

Device and Tag properties can be displayed with the “Properties” command. See Figure 2, 3 and 4 for an 
example of the Device and Tag properties dialog box. 
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Figure 2 
 
 
 

Figure 3 
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Figure 4 
 

Export tags 
 

MOS tags can be Exported to a *.CSV (Comma Separated Value) file for input to Microsoft Excel or other similar 
programs. To Export the OPC Server tags select “Export Tags…” from the Main Menu. 

 
Figure 5 
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This results in the Export Tags dialog box being displayed. 

 
Figure 6 

Specify a File name and a directory if you want the file to be saved in a directory other than the default directory. 
Then select “Save” and the file will be saved as a *.csv file. The Tag export file has the following format: 

 

TagName DataType AccessRights 
Anlz138.ComState 3 1 
Anlz138.Name 8 1 
Anlz138.SetTime 7 3 
Anlz138.App001.CurrStrm 3 1 
Anlz138.App001.Name 8 1 
Anlz138.App001.RunState 3 1 
Anlz138.App001.Strm001.AlarmMsg 8 1 
Anlz138.App001.Strm001.AlarmStatus 3 1 

 

3.4. OPC Server Configuration 
OPC Server configuration is a relatively fast and easy process of defining the analyzers (devices) and Tags 
(OPC Items) that will be available for OPC Clients to access. 

Configuration consists of the following steps: 

1. Start MaxumOPCServer service. 
There are three ways to start the MOS service. 
h. Automatically at power-up. 
i. Manually using Windows Service Control Console (SCM). 
j. Automatically using Maxum OPC Client. 

2. Start the user interface application MaxumOPCClient. 
3. Add a new device or analyzer to OPC Server. 
4. Add one or more applications to the device folder. 
5. Add one or more streams to the application folder. 
6. Add one or more components to the stream folder. 
7. Add one or more component details to the component folder. 
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3.4.1. Configuration Description 

Step 1: Start MaxumOPCServer service 
 

a. How to start MOS service automatically 
at power-up. 
Start the windows Service Control Manager 
(SCM) utility. Scroll down to 
MaxumOPCServer service. Right click on the 
service and select Properties from the pop-up 
menu. Change the Startup type to 
Automatic. This is the recommended setting 
for MOS service. 

 
b. How to start MOS service manually. 
Start the windows Service Control Manager 
(SCM) utility. Scroll down to 
MaxumOPCServer service. Right click on the 
service and select Properties from the pop-up 
menu. Click the Start button to manually start 
the MOS service. 

 
c. How to start MOS service automatically 
using Maxum OPC Client. 

On startup Maxum OPC Client queries the service database to 
determine if the MOS service is running. If the MOS service is 
not running the OPC Client will start the MOS service and 
connect to it. If the MOS service is already running the Client 
connects to the running service. The OPC Client will not stop 
the MOS service on exit. Once the service is running the only 
way to stop it is with the SCM. 
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Step 2: Start the user interface application, MaxumOPCClient 
 

Double click the desktop icon or Select Start- 
>Run then Browse to the MaxumOPCClient.exe 
program. Click OK. 

 
If the following error is displayed use the Run as 
Administrator option to start MOC. 

 
… or see the section titled “Starting MOS Without Administrator Privileges” 
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To use the Run as Administrator option follow these steps: 

a. Using Windows explorer browse to the directory where the MaxumOPCClient.exe file is located. 
b. Right click on the file name, select Run as Administrator from the pop-up menu. 

 
Or, select Properties from the pop-up menu and check the Run this program as an administrator check box. 
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Step 3: Add a new device or analyzer to OPC Server. 
 
 

Choose Add->New Device… 

 
from the main menu or click on the 
Add New Device Icon on the 
toolbar 

 
Figure 7 

. 
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Step 4: Specify the device’s network address 
 

(See Figure 8). Then click on OK. 
 

Maxum, Maxum Edition II, 
MicroSam analyzers: Maxum 
analyzers use TCP/IP (Internet 
Protocol) addressing. IPv4 uses a 
32-bit address to identify a 
machine on a network and the 
network to which it is attached. 
The IP addresses are usually 
written out in their decimal 
equivalents in dotted quad 
notation, four decimal integers, 
ranging from 0 to 255 each. 
(xxx.xxx.xxx.xxx (ex. 
196.198.52.2) ). Each Maxum 
analyzer must be assigned a 
unique address. 

 
Figure 8a. Maxum analyzer 10.10.0.110 

Advance Optichrom (legacy) 
analyzer addressing: 
For Optichrom analyzers the IP 
address plus the logical ID 
(Analyzer number) determine the 
device address. 
Optichrom analyzers use Advance 
Data Hiway (ADH) addressing 
consisting of a Loop (1-8) and a 
Unit (1-31) and require the use of 
an Advance Network Gateway 
board to convert the electrical 
signals from ADH to Ethernet 
TCP/IP. Typically an NAU is 
configured as an Optichrom Data 
Server (ODS). The ODS converts 
the Optichrom messages to 
Maxum format. For example if the 
ODS IP address is 10.10.0.110 
and the Optichrom analyzer 
Logical ID is 115 then the address 
would be specified as shown in 
figure 8b. 
First enter the ODS IP address in 
the IP address box, then check 
the “Select this box if the device is 
an Optichrom analyzer” checkbox. 
Finally specify the Logical ID of 
the Optichrom analyzer in the 
“Enter the device (Anlz) Number” 
box. 

 
Figure 8b. Optichrom analyzer 115 reporting to NAU 10.10.0.110 

configured as Optichrom Data Server (ODS) 
 

NOTE: This is the only exception to the rule that the IP address must be 
unique for each analyzer. Up to 50 Optichroms can use the same ODS with 
OPC Server. This means that all 50 Optichroms would specify the same IP 
address, yet each Optichrom has a unique system address consisting of 
the IP + Logical ID. 
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Step 5: Specify the Applications and Streams to create OPC Tags for. 
 

The MOS connects with 
the device and sends a 
query to determine the 
available Applications and 
Streams. The Device 
Setup dialog box is 
automatically displayed. 
Select the specific 
Application(s) and 
Stream(s) by clicking on 
the appropriate checkbox 
under the Enable column 
or select all of the 
Applications and 
associated Streams by 
clicking the left mouse 
button on the Select All 
checkbox. (See Figure 9). 
Click on OK to create the 
Device, Application, and 
Stream folders with their 
associated Tags. 

 

Figure 9 

Notice that the Device Setup dialog box displays the available Applications ID’s, Stream ID’s, and for Maxum 
only whether the stream is a normal process stream or a Calibration stream and the Application name. Figure 10 
shows the newly created OPC Tags. 

 
Figure 10 

The configuration program automatically adds the Device Folder in the Device pane and labels the device with 
either “Anlzxxx” or “NAUxxx”. Where “xxx” is replaced with the device’s logical ID. See Figure 10 (Anlz110). 
The following device level tags are automatically added to the Tag View pane under the device: AlarmMsg, 
AlarmStatus, ComState, Name, and SetTime. 
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Located directly under the device folder in the Device pane is the Application folder(s). (See Figure 11) 
 

 
Figure 11 

Each application folder is given the name “Appxxx”. Where “xxx” is replaced with the Application number. In the 
example in Figure 11 its App001. The following Application level tags were automatically added to the Tag View 
pane: AlarmMsg, AlarmStatus, CurrStrm, Enable, InService, Name, RunState, and StrmSeq. Located directly 
under the Application folder in the Device pane is the Stream folder(s). Each Stream folder is given the name 
“Strmxxx”. Where “xxx” is replaced with the Stream number. In the example in Figure 12 its Strm001. 

 

 
Figure 12 
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Step 6: Specify each Stream’s component tags. 
 

Notice that there are no stream 
components or results tags shown 
under the Stream folders in figure 
12. To specify the stream 
dependent Components select 
“Add” from the main menu then 
“New Component” or click the left 
mouse button over the desired 
stream in the Device pane then 
right click to display the pop-up 
menu and select “New 
Component(s)”, or select the Add 
“New Component(s)” button from 
the tool bar. The MOS sends a 
query to the device to determine the 
available components for the 
specified stream. 

IMPORTANT – For Maxum and 
Maxum Edition II devices the 
components are only displayed in 
the Component Selection dialog 
box that have a sequence number 
defined in the Trtval attribute of the 
Result table. 

 
Figure 13 

Select the specific Components by clicking on the appropriate checkbox under the Enable column or select all of 
the stream components by clicking the left mouse button on the Select All checkbox. Then select OK to create 
the Component folder(s) and associated Tags. (See Figure 13) 

Each Component is given its own folder under its associated stream. Each component folder is given the name 
“Compxxx”, where “xxx” is replaced with the Component number (as defined in TrtVal). The following 
Component level tags were automatically added to the Tab View pane: Name, ValCompare, ValMargin, 
ValState, and Value. (see Figure 14) 

 
Figure 14 
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Step 7: Adding Component detail tags 
 

Note: Detail tags are only 
supported in Maxum analyzers. 

Once the Component tags have 
been added to a stream additional 
Component Detail tags may be 
added to each component 
depending on the Component’s 
type. Maxum supports three types: 
Values, Peaks or Groups. Groups 
support two types: Peak groups and 
Calibrated groups. 
To add one or more Detail tags to a 
component first select the 
component in the Device pane. 
Then select “Add” from the main 
menu then “Component details…” 
or right click the mouse on the 
component and select “Component 
details” from the pop-up menu, or 
select the “Add Details” button from 
the tool bar. The Component Detail 
dialog box will be displayed for 
Peaks, Peak groups or Calibrated 
groups. The Component Detail 
dialog will not be displayed for 
component types of Values. 

 
Figure 15 

Select the specific Component details by clicking on the appropriate checkbox(s) on the Component Detail dialog 
box. Depending on the Component type either the Peak or Group section will be enabled. The Peak section tags 
are enabled for Peak or Peak groups types while the Group section tags are enabled for Calibrated group types. 
Select OK to create the Component detail tag(s) (See Figure 16) 

 

 

Figure 16 
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Step 8: Saving Tag Configuration File Changes 
 

Save the changes to the Tag configuration file by selecting “File”, “Save As” from the Main Menu. 

Figure 17 
 

This results in the MOS displaying the “Save As” dialog box. Specify the desired configuration file name under 
the “File name:” edit box and select “Save”. This will save the Configuration file under the specified directory. 
This file will automatically load and run the next time the MOS program is started. (see Figures 17 & 18) 

 
 

Figure 18 
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Figure 19 

 
4. DCOM Configuration 

The OPC DA specification is based on Microsoft’s COM technology. COM (Component Object Model) is a 
binary-interface standard for software components that enables inter-process communication and dynamic object 
creation. DCOM (Distributed Component Object Model) is a protocol that enables COM objects to communicate 
over a reliable, secure, and efficient network link. 

 
Maxum OPC Server (MOS) is an OPC DA server that uses COM/DCOM to communicate with remote OPC 
Clients. COM/DCOM access and security permissions must be configured on both the OPC Server and Client 
machines to allow communication between DCOM (OPC) objects. 

Windows provides a COM/DCOM configuration utility called DCOMCNFG. This section describes how to use 
the utility to allow communication between Maxum OPC Server and a remote OPC Client. 

 
 

IMPORTANT: Inadvertently changing DCOM settings can potentially make your PC inoperable. 
Document any changes you make to your DCOM settings. If you have problems 
restore the original settings. Read through this document before you make any 
changes to your DCOM Configuration Properties. This document is intended to 
provide guidance for proper DCOM setup. The settings suggested here may need to 
be varied for your situation depending on your OPC Client application and network 
security requirements. It is suggested that you review your DCOM settings with your 
network Administrator prior to making any changes. 

 
IMPORTANT : Make sure you are logged in as the Administrator or on an account with Administrator 

rights before attempting to modify the DCOM settings. The instructions here are for 
Windows 7. There may be slight differences in the setup steps for Windows XP, 
Server 2003, Windows 8.1, Windows 9, and Server 2012. 
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Step 1: Start the DCOM configuration 
utility by selecting Start->Run or use the 
Windows Key + R shortcut to launch 
the Run window. 

 
Step 2: Type in DCOMCNFG and click OK. 

 
Figure 4.1 

Step 3: In the Component Services windows, navigate to 
Console Root->ComponentServices->Computers then 
right-click on My Computer and 
select Properties from the pop-up menu. 

 
Figure 4.2 
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Step 4: On the My Computer 
Properties window, select the 
Default Propertes tab. (see 
Figure 4.3) 

Verify that the following settings are 
properly configured: 
a: Enable Distributed COM on the 

computer option is checked. 
IMPORTANT : Any time this 
option is changed you must re- 
boot the PC for the change to 
take effect. 

b: Default Authentication Level is 
set to None. 

c: Default Impersonation Level is 
set to Identify. 

 
Figure 4.3 

Step 5: Select the COM Security 
tab. 

 
Figure 4.4 
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Step 6: Under Access 
Permissions, select the Edit 
Default button. (Figure 4.4) 
Add the following groups to the 
Group or user names list. Do 
not remove any others that may 
already be listed. (Figure 4.5) 

a: Anonymous Logon – this must 
be added to the defaults in order 
for OPC Enumerator to function 
correctly. 

b: Everyone 
c: Interactive 
d: Network 
e: System 
Make sure that both the Local and 
Remote Access permissions are set 
to Allow. (see Figure 4.5) 

 
Click on OK. 

 
Figure 4.5 

Step 7: Under Launch and 
Activation Permissions select 
the Edit Default button. 
(Figure 4.4) 
Add the following groups to the 
Group or user names list. Do 
not remove any others that may 
already be listed. (Figure 4.6) 

f: Anonymous Logon – this must 
be added to the defaults in order 
for OPC Enumerator to function 
correctly. 

g: Everyone 
h: Interactive 
i: Network 
j: System 

 
Make sure that both the Local and 
Remote Access permissions are set 
to Allow. (see Figure 4.6) 

 
Click on OK. 

 
Figure 4.6 

Step 8: Under My Computer, open the folder labeled DCOM Config. (see Figure 4.7) 
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Figure 4.7 

Step 9: Browse to the Siemens 
MaxumOPCServer COM object. 
Right-click, and select Properties from the pop- 
up menu. 
On the General tab, set the Authentication 
Level to None. 
(see Figure 4.8) 

 
Figure 4.8 
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Step 10: 
Select the Security tab. 
Under the Launch and Activation 
Permissions, select Customize. 
Then click Edit. (see Figure 4.9) 

Step 11: 
Select the Security tab. 
Under the Launch and Activation Permissions, 
select Customize. 
Then click Edit. (see Figure 4.9) 

 
Figure 4.9 

Step 12: 
Add the following groups to the Group or user 
names list. Do not remove any others that may 
already be listed. (Figure 4.10) 

a: Everyone 
b: Interactive 
c: Network 
d: System 

 
Make sure that both the Local and Remote 
Launch and Activation permissions are set to 
Allow. (see Figure 4.10) 

 
Click on OK 

 
Figure 4.10 
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Step 13: 
Under Access Permissions (see Figure 4.9) , 
select Customize. 
Then click Edit. (see Figure 4.9) 
Add the following users to the Group or user 
names list. Do not remove any others that may 
already be listed. 

a: Everyone 
b: Interactive 
c: Network 
d: System 

 
Make sure that both the Local and Remote 
Access permissions are set to Allow. (see Figure 
4.11) 

 
Click on OK. 

 
Figure 4.11 

Step 14: 
Select the Endpoints tab. (see Figure 4.9) 
Make sure the Connection-oriented TCP/IP is 
entered in the list. 
Click the Add button, select Connection- 
oriented TCP/IP in the dropdown list and the 
Use default endpoints radio button. (see 
Figure 4.12) 
Click OK. 

 
Figure 4.12 
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Step 15: 
Select the Identity tab. 
Make sure The system account (service 
only) radio button is selected. 
Click Ok. (This is the recommended option for 
COM objects running as a service.) 

 
Figure 4.13 
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5. Theory of Operation 

5.1. Device Connection 
OPC Server uses TCP/IP over Ethernet to communicate with Maxum, Maxum Edition II, NAU, MicroSam, and 
Advance Optichrom analyzers. When a new device is added to OPC Server a connect message is sent to the 
remote device. If the connection is successful, the server sends a query to determine the device firmware 
version number. The firmware version must be equal to or greater than 4.0 for the connection process to 
continue. Once the server has verified the device version number the server sets up (registers) three Active 
queries (subscribes) for a Maxum device or two Active queries for an Optichrom device.(See tables below) This 
completes the connection process. 

 
 

5.1.1. Maxum/NAU ACTIVE QUERIES: 
When OPC Server connects to an analyzer it sets up three Active queries in the analyzer’s database. When any 
of the attributes associated with an active query have a change in value the OPC Server is automatically notified 
and updated. The three active queries are: 

 
Active queries 

 
 Maxum Database Table Table Attributes 

1 OPC lastreceived 
2 OPC force 

enable 
runstatus 

3 Application enable 
inservice 
mode 

 
Active query #1 is configured on the OPC table - lastreceived attribute. Lastreceived is updated at the end of 
each analysis cycle and contains the date and time the analysis cycle completed. This query is used to update 
all of the OPC tags at the end of the analysis cycle. 

Active query #2 is configured on the OPC table - force, enable, and runstatus. This query automatically updates 
the OPC tags – Force, Stream Enable, and RunState tags whenever there is a change in value on any of these 
database attributes. 

Active query #3 is configured on the Application table – enable, inservice, and mode attributes. This query 
automatically updates the Application mode attributes whenever there is a change in value. 

 
 

5.1.2. OPTICHROM ACTIVE QUERIES: 
 

Table Name Table Attributes(s) 
OPC lastreceived 
OPC enable, force, runstatus 

 
5.2. Device Updates 

At the end of each analytical cycle the analysis results are updated in the device (analyzer) database. The 
lastreceived attribute is updated to reflect the time the analysis cycle completed. Any change to the lastreceived 
attribute activates an Active query forcing the event notification to be sent to OPC Server. OPC Server responds 
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with a query for the analysis results. The Server overwrites the previous analysis cycle results and updates any 
interested OPC Clients with the new data. 

 

5.3. OPC Client 
A client is defined as a requester of services and a server is defined as the provider of services. A single 
machine can be both a client and a server depending on the software configuration. 

An OPC client is any OPC compatible application that wants to use the information stored in Maxum OPC 
Server. A typical client is a DCS (Distributed Control System) or SQC program that supports an OPC interface. 

OPC clients connect to OPC Server by creating an OPC Group object and specifying the OPC Items (tags) to be 
included in the group. The client registers and subscribes to server data by creating an advise sink which 
receives data change notifications from the server. OPC is change-driven. Data is only sent when there is a 
change in value. 

OPC Groups have several properties that must be specified when the group is created in the OPC Server. One 
property of an OPC Group is the update rate. The update rate is the rate at which data changes should be 
evaluated and sent to the client. 

 
5.3.1. The Registry 

OPC clients locate OPC Servers on the local or remote machine through a set of entries in the Windows 
Registry. Chapter 6 of the OPC Specification discusses the registry entries necessary for an OPC server. A 
COM class is identified through a CLSID (ClassID). The operating system maintains a database of all registered 
CLSIDs in the Registry. The registry entries for a server’s CLSID specify the location of the server, its type (local 
, remote, in-process), threading model, etc. Maxum OPC Server is self-registering. The first time OPC Server is 
executed, a set of entries is installed in the Registry. Registration entries are made under 
HKEY_LOCAL_MACHINE\CLASSES\Siemens.MaxumOPCServer.1, referred to as the ProgID. A subkey 
located under this key contains the CLSID for Maxum OPC Server. Clients use the registration information to 
find the server path. 
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5.5. OPC Server Tags 
5.5.1. Maxum, Maxum Edition II, NAU, MicroSam Tags 

Access Types: R = Read Only, RW = Read/Write, W = Write Only. “xxx” = analyzer logical ID 
 

 

Tag Name 
A

cc
es

s 
Ty

pe
  

Database Location (Source) 

 

Description 

Device.Tag – Example: Anlzxxx.AlarmMsg 

AlarmMsg R OPC table “sysmsg” attribute. String value (VT_BSTR) that displays the highest priority device level Alarm message 

AlarmStatus R OPC table “sysalmstatus” attribute. 4-byte integer value (VT_I4) that displays the device alarm status 
0 = OK, Normal 
1 = WARNING ALARM 
2 = FAULT ALARM 
3 = WARNING & FAULT ALARM 

ComState R Set by the MOS based on the connection state 
between the MOS and the device (anlz, NAU). 

4-byte integer value (VT_I4) that displays the current status of the communication link 
between the MOS and the device 
0 = OK, Normal 
2 = COMMUNICATION FAILURE between device and server 
4 = Optichrom analyzer timeout 

Name R System_Control table “name” attribute. String (VT_BSTR) that contains the device name 

SetTime W OPC table “settime” attribute. OLE Date tag (VT_DATE); sets the device and/or system time. A Maxum analyzer or 
NAU can be configured as a Time server. SetTime updates the time/date in the 
designated Time server. The other devices in the system must be configured with the 
IP address of the designated Time Server. Maxum devices automatically synchronize 
their time base once a day at 12:20am. 
Write format: Time may be entered in 12 or 24-hour format 

06/11/2003 01:28 pm or 6-11-2003 13:28 
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Tag Name 

A
cc

es
s 

Ty
pe

  

Database Location (Source) 

 

Description 

Application.Tag – Example: Appxxx.AlarmMsg 

AlarmMsg R AlarmMsg - Application table "app_status_msg" 
attribute. 

String tag (VT_BSTR) that contains the current application error message. AlarmMsg 
always contains the highest priority FAULT or WARNING alarm message. Displays a 
NULL string for no alarm. 

AlarmStatus R AlarmStatus - Application table "app_status" 
attribute. 

4-byte integer (VT_I4) that contains the current application alarm status. 
0 = OK, Normal 
1 = WARNING ALARM 
2 = FAULT ALARM 
3 = WARNING & FAULT ALARM 

CurrStrm R CurrStrm - OPC table "nextstream" attribute. 4-byte integer (VT_I4) that contains the number of the stream currently being analyzed 
by the application 

Enable RW Enable - Application table “app_status” attribute. Boolean (VT_BOOL) that enables or disables this application 
0 = This application DISABLED 
1 = This application ENABLED 

Write format: 0 or 1 

InService R InService - Application table "inservice" attribute. Boolean (VT_I4) that contains the current service state for this application 
0 = This application is OUT OF SERVICE 
1= This application is IN SERVICE 

Write format: 0 or 1 

Name R Name - Application table "application_name" 
attribute. 

String (VT_BSTR) that contains the name of this application 

RunState RW RunState - OPC table "runstatus" attribute. 4-byte integer (VT_I4) that sets the state of this application. 
0 = This application is in HOLD 
1= This application is in the RUN state 
2 = This application is in the CALibration state 
3 = This application is in the Validation state 
4 = Analyzer timeout valid for Optichrom analyzers only 

Other values are not allowed. 
Write format: range 0 - 2 

StrmSeq RW StrmSeq - Application table "active_sequence" 
attribute. 

4-byte integer (VT_I4) that sets/displays the active application stream sequence. 
Write format: positive integer greater than zero 
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Stream.Tag – Example: Strmxxx.AlarmMsg 

AlarmMsg R AlarmMsg - OPC table "alarmmsg" attribute. String tag (VT_BSTR) that contains the highest priority WARNING or FAULT error 
message for this stream 

AlarmStatus R AlarmStatus - OPC table "alarmstatus" attribute. 4-byte integer (VT_I4) tag that contains the current stream alarm status. 
0 = OK, Normal 
1 = WARNING ALARM this stream 
2 = FAULT ALARM this stream 
3 = WARNING & FAULT ALARM this stream 

CycleLength R OPC table “cyclelength” attribute. 4-byte integer (VT_I4): Stream cycle length in seconds 

DataReady R MOS internally generated when the SampleTime 
tag is updated 

Boolean (VT_BOOL): Set to a ‘1’ at the end of the analysis cycle. It is reset after a user 
defined period between 5 - 25 seconds. The default is 10 seconds. 

Enable RW Enable - OPC table “enable” attribute. Boolean tag (VT_BOOL): Sets this stream ENABLE/DISABLE state 
0 = This stream DISABLED 
1 = This steam ENABLED 

Write format: 0 or 1 

Force RW Force - OPC table “force” attribute. Boolean tag (VT_BOOL): Forces this stream to run repeatedly 
0 = Normal Stream Sequencing 
1= Force this stream to run next 

Write format: 0 or 1 

MethodID R MethodID – result table “method_id” attribute 4-byte integer (VT_I4): Method ID used on this stream 

Name R Name - OPC table “streamname” attribute. String (VT_BSTR): Stream name 

RunEvent RW RunEvent - OPC table “runevent” attribute. 4-byte integer (VT_I4) Runs a stream-dependent event. Example: To run EVT32 in the 
analyzer, write 32 to this tag. 
Write format: Positive integer in the range 1- 32535 

SampleTime R SampleTime - OPC table “lastreceived” attribute Date tag (VT_DATE) Contains the time the sample was injected for the associated 
components (results) on this stream. 
Updated at the end of the analysis cycle with the date/time the stream analysis was 
started. 

SetAlarm RW SetAlarm - OPC table “setalarm” attribute. 4-byte integer (VT_I4) Sets an alarm in the device. 
Write format: Positive integer in the range 1- 32,535 
Example: To force an Alarm 54 in the device, write 54 to this tag. 
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Component.Tags 
The Name and Value tags are automatically created for each component on Process, Validation, or Calibration streams 

Name R Name - Result table “result_name” attribute. String tag (VT_BSTR): Contains the name of this component 

Value R Value - OPC table "results" attribute. 4-byte real tag (VT_R4): Contains the value of the component 

Component ValidationTags 
The ValCompare, ValMargin, and ValState tags are automatically created for each component on a Validation stream only 

Works with Peaks, Peakgroups, and Calibratedgroups 

ValCompare R ValCompare - Result table “compare_value” 
attribute. Used for validation. 

8-byte real tag (VT_R8): Used in validation to compute a difference between the 
buffered result value 

ValMargin R ValMargin - Result table "compare_margin" 
attribute. This is a percentage of full scale. 

8-byte real tag (VT_R8): Used to specify the valid range for comparison between the 
buffered result value and the ValCompare value. 

ValState R ValState - Result table “compare_state” attribute. 
Used for validation. 

8-byte real tag (VT_R8): Provides Validation state information. 
(Pass = 1/Fail = 2/Validation Inprogress = 8) 

Component Detail PeakTags 
The following Component detail tags are valid on Process, Validation, and Calibrations streams. 

These tags are valid for Peaks and Peak groups only. 

Current_RF R Current_RF - ezchrom_result_chrompeak table 
“current_rf” attribute. 

8-byte real tag (VT_R8): Contains the value of the Response Factor used on the 
current analysis. Maybe calculated or manually entered response factor. 

PkArea R PkArea - ezchrom_result_chrompeak table 
“corrected_area” attribute. 

8-byte real tag (VT_R8): Contains the corrected peak area for this component 

PkArea% R PkArea% - ezchrom_result_chrompeak table 
“area_percent” attribute. 

8-byte real tag (VT_R8): Contains the percent area for this component 

PkAsym R PkAsym - ezchrom_result_chrompeak table 
“asymmetry” attribute. 

8-byte real tag (VT_R8): Contains the peak asymmetry for this component 

PkAsym10 R PkAsym10 - ezchrom_result_chrompeak table 
“asym10” attribute. 

8-byte real tag (VT_R8): Contains the Asymmetry at 10% peak height for this 
component 

PkHeight R PkHeight - ezchrom_result_chrompeak table 
“peak_height” attribute. 

8-byte real tag (VT_R8): Contains the maximum peak height for this component 

PkHeight% R PkHeight% - ezchrom_result_chrompeak table 
“height_percent” attribute. 

8-byte real tag (VT_R8): Contains the percent height for this component 
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PkNoise R PkNoise - ezchrom_result_chrompeak table 
“peak_noise” attribute. 

8-byte real tag (VT_R8): Contains the peak noise for this component 

PkResolution R PkResolution - ezchrom_result_chrompeak table 
“resolution” attribute. 

8-byte real tag (VT_R8): Contains the peak resolution relative to previous peak for this 
component 

PkRetTime R PkRetTime - ezchrom_result_chrompeak table 
“retention_time” attribute. 

8-byte real tag (VT_R8): Contains the retention time at peak apex for this component 

PkSignaltoNoise R PkSignaltoNoise - ezchrom_result_chrompeak 
table 
“peak_signal_to_noise” attribute. 

8-byte real tag (VT_R8): Contains the peak signal to noise for this component. (Peak 
height / rms noise) 

PkStartFlg R PkStartFlg - ezchrom_result_chrompeak table 
“start_flag” attribute. 

String tag (VT_BSTR): Contains the peak start flag for this component 

PkStartTime R PkStartTime - ezchrom_result_chrompeak table 
“front_time” attribute. 

8-byte real tag (VT_R8): Contains the retention time at start of peak for this component 

PkStopFlg R PkStopFlg - ezchrom_result_chrompeak table 
“stop_flag” attribute. 

String tag (VT_R8): Contains the peak stop flag for this component 

PkStopTime R PkStopTime - ezchrom_result_chrompeak table 
“back_time” attribute. 

8-byte real tag (VT_R8): Contains the retention time at end of peak for this component 

PkType R PkType - ezchrom_result_chrompeak table 
“peak_type” attribute. 

8-byte real tag (VT_R8): Contains the peak type this component 

PkUSPWidth R PkUSPWidth - ezchrom_result_chrompeak table 
“usp_peak_width” attribute. 

8-byte real tag (VT_R8): Contains the peak USP width (U.S. Pharmacopeia) for this 
component 

PkWidth R PkWidth - ezchrom_result_chrompeak table 
“peak_base_width” attribute. 

8-byte real tag (VT_R8): Contains the peak width at base for this component 

PkWidth10 R PkWidth10 - ezchrom_result_chrompeak table 
“peak_width10” attribute. 

8-byte real tag (VT_R8): Contains the peak width at 10% height for this component 

PkWidth5% R PkWidth5% - ezchrom_result_chrompeak table 
“peak_width5” attribute. 

8-byte real tag (VT_R8): Contains the peak width at 5% height for this component 

PkWidth50 R PkWidth50 - ezchrom_result_chrompeak table 
“peak_width50” attribute. 

8-byte real tag (VT_R8): Contains the peak width at 50% height for this component 

TheorPlates R PkTheorPlates - ezchrom_result_chrompeak table 
“theor_plates” attribute. 

8-byte real tag (VT_R8): Contains the Theoretical plates for this component 
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Component Detail GroupTags 
The following Component detail tags are valid on Process, Validation, and Calibrations streams. 

These tags are valid for Calibrated groups only. 

GrpArea R GrpArea - ezchrom_result_group table 
“corrected_area” attribute. 

8-byte real tag (VT_R8): Contains the corrected peak area ( for the group) for this 
component 

GrpArea% R GrpArea - ezchrom_result_group table 
“area_percent” attribute. 

8-byte real tag (VT_R8): Contains the peak area percent ( for the group) for this 
component 

GrpHeight R GrpHeight - ezchrom_result_group table 
“group_height” attribute. 

8-byte real tag (VT_R8): Contains the maximum peak height ( for the group) for this 
component 

Component Detail Calibration Tag 
The following Component detail tag is valid on Process, Validation, and Calibrations streams. 

This tag is valid on Process, Validation, and Calibration streams on Peaks, Peak groups, and Calibrated groups. 
 

RespFactL(0-9) 

 

R 

 

RespFactL(0-9) - ezchrom_result_group table 
“response_factor” attribute. 

 
RespFactL0 – RF level 1 or single point cal 
. 
. 
RespFactL9 – RF level 10 for multipoint cal 

 

8-byte real tag (VT_R8): Contains the calibration response factor. Supports up to 10 
levels of response factors for multipoint calibrations. 



Maxum OPC Server 
User Manual, 9/2014, v1.0a, 2000684-001 51 

 

 

 

5.5.2. Advance Optichrom Tags 
Access Types: R = Read Only, RW = Read/Write, W = Write Only. 
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Device.Tag – Example: Anlzxxx.AlarmMsg (xxx = Analyzer logical ID) 

ComState R Set by the MOS based on the connection state 
between the MOS and the device. 

4-byte integer value (VT_I4) that displays the current status of the communication link 
between the AOS and the device 

0 = OK, Normal 
1 = COMMUNICATION FAILURE between device and server 

Name R System_Control table “name” attribute. String (VT_BSTR) that contains the device name 

SetTime W OPC table “settime” attribute. OLE Date tag (VT_DATE); sets the device and/or system time. Writing the SetTime 
tag for an Optichrom device results in a Optichrom TOD(Time of Day) broadcast. This 
will synchronize the date/time on all the Optichrom devices connected to the network. 
Write format: Time may be entered in 12 or 24-hour format 

06/11/2003 01:28 pm or 6-11-2003 13:28 

Application.Tag – Example: Appxxx.AlarmMsg (xxx = Application ID) 

CurrStrm R CurrStrm - OPC table "nextstream" attribute. 4-byte integer (VT_I4) that contains the number of the stream currently being analyzed 
by the application 

Name R Name - Application table "application_name" 
attribute. 

String (VT_BSTR) that contains the name of this application (Optichrom is always 
“App001”) 

RunState RW RunState - OPC table "runstatus" attribute. 4-byte integer (VT_I4) that sets the state of this application. 
0 = This application is in HOLD 
1= This application is in the RUN state 
2 = This application is in the CALibration state 
4 = Optichrom loss of communication with OPC Server 

Other values are not allowed. 
Write format: range 0 – 2 

0 = Sets application to HOLD state 
1 = Sets application to RUN state (Write 7, Read 1) 
2 = Sets application to CAL state 
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Stream.Tag – Example: Strmxxx.AlarmMsg (xxx = Stream ID) 

AlarmMsg R AlarmMsg - OPC table "alarmmsg" attribute. String tag (VT_BSTR) that contains the highest priority WARNING or FAULT error 
message for this stream 

AlarmStatus R AlarmStatus - OPC table "alarmstatus" attribute. 4-byte integer (VT_I4) tag that contains the current stream alarm status. 
0 = OK, Normal 
1 = WARNING ALARM this stream 
2 = FAULT ALARM this stream 
3 = WARNING & FAULT ALARM this stream 

CycleLength R OPC table “cyclelength” attribute. 4-byte integer (VT_I4): Stream cycle length in seconds 

DataReady R MOS internally generated when the SampleTime 
tag is updated 

Boolean (VT_BOOL): Set to a ‘1’ at the end of the analysis cycle. It is reset after a user 
defined period between 5 - 25 seconds. The default is 10 seconds. 

Enable RW Enable - OPC table “enable” attribute. Boolean tag (VT_BOOL): Sets this stream ENABLE/DISABLE state 
0 = This stream DISABLED 
1 = This steam ENABLED 

Write format: 0 or 1 

Force RW Force - OPC table “force” attribute. Boolean tag (VT_BOOL): Forces this stream to run repeatedly 
0 = Normal Stream Sequencing 
1= Force this stream to run next 

Write format: 0 or 1 

Name R Name - OPC table “streamname” attribute. String (VT_BSTR): Stream name 

RunEvent RW RunEvent - OPC table “runevent” attribute. 4-byte integer (VT_I4) Runs a stream-dependent event. Example: To run EVT32 in the 
analyzer, write 32 to this tag. 
Write format: Positive integer in the range 1- 32535 

SampleTime R SampleTime - OPC table “lastreceived” attribute Date tag (VT_DATE) Contains the time the sample was injected for the associated 
components (results) on this stream. 
Updated at the end of the analysis cycle with the date/time the stream analysis was 
started. 

Component.Tag – Example: Compxxx.AlarmMsg (xxx = Component ID) 

Name R Name - Result table “result_name” attribute. String tag (VT_BSTR): Contains the name of this component 

Value R Value - OPC table "results" attribute. 4-byte real tag (VT_R4): Contains the value of the component 
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Appendix A - DCOM Logging 
 

DCOM logging can be a useful troubleshooting tool when experiencing DCOM errors. By default Windows 
disables DCOM logging. You can enable error logging by changing the registry and then restarting the DCOM 
process (OPC Client/Server) that you want to examine. The DCOM process that you want to examine 
determines whether you have to restart the computer. 

To turn on DCOM error logging, follow these steps: 

1. Click Start, click Run, type regedit, and then click OK. 
2. Locate the HKEY_LOCAL_MACHINE\SOFTWARE \Microsoft\Ole registry subkey. 
3. Right-click the Ole value, point to New, and then click DWORD Value. 
4. Type ActivationFailureLoggingLevel, and then press ENTER. Double-click 

ActivationFailureLoggingLevel, type 1 in the Value data box, and then click OK. 
5. Right-click the Ole value, point to New, and then click DWORD Value. 
6. Type CallFailureLoggingLevel, and then press ENTER. Double-click CallFailureLoggingLevel, type 1 

in the Value data box, and then click OK. 
7. Restart the DCOM program, and then examine the System log and the Application log for DCOM errors 

(Event Viewer). 
8. The error messages in the Windows event log contain information that you can use to help resolve the 

DCOM issue. 
 

You can turn off DCOM error logging by changing the ActivationFailureLoggingLevel value and the 
CallFailureLoggingLevel value to zero. 



 

 

Appendix B - Configuring Windows Firewall 
By default, Windows blocks inbound connections from other computers. To allow OPC Clients to connect to 
MaxumOPCServer, Windows Firewall must be configured to allow inbound messages from the client. If the 
client and server are located on different computers you must configure Windows Firewall on both machines. If 
the client and server are used on the same computer, there is no need to configure Windows firewall. 
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Step 1: Open Windows Firewall Management 
Console. Select Start then type wf.msc in the 
Search programs and files box. 

 
Step 2: In the left pane select Inbound Rules then 

browse and select the Windows Management 
Instrumentation (DCOM-In) rule. Right click and 
select Properties from the pop-up menu. From the 
General tab check the Enabled check-box and 
then click on OK. 
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Next, right click on Inbound Rules and select New Rule... from the pop-up menu. Set the Program radio button 
then click Next. 

 

Under This program path: browse to the MaxumOPCServer.exe file and select Next. 



 

 

Set the Allow the connection radio button and then select Next. 

 

On the Profile screen check Domain, Private, and Public check boxes then select Next. 
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Give the inbound rule a name MaxumOPCServer and select Finish. 

IMPORTANT: An inbound rule to allow connections must exist for every OPC server running on the 
computer. This includes the OPC Foundation's OPCEnum.exe program. OPCEnum 
is used by an OPC Client application to discover and/or connect to OPC servers on a 
remote machine. OPCEnum acts as a ‘proxy’ application to access important registry 
information on the remote computer. If an OPC client can not browse the list of 
servers on a remote machine, it is typically a result of authentication failure to the 
OPCEnum application. 



 

 

Appendix C - OPC Test Client 
A simple OPC Client is provided with each installation of Maxum OPC Server. The FactorySoft OPC Client is 
useful for testing and troubleshooting OPC servers and OPC connections. 

The Client is installed in the \Program Files (x86)\Siemens Industry\Client directory. To access the FS Client add 
a shortcut to the Desktop or select Start, Run…, Browse to the OPC Client.exe, and click on OK to start the 
program. 

 

From the main menu connect to an 
OPC Server. Select OPC- 
>Connect… . (See Figure C--1) 

 
Figure C-1 

When the Select OPC Server 
dialog box is displayed enter the IP 
address of the remote device in 
the Server Node combo box (if the 
OPC Server and OPC Client are 
running on the same machine 
leave the box empty) then click on 
the Refresh List box. (See Figure 
C-2) The OPC Client launches the 
OPC Foundation List Server 
(OPCEnum.exe) on the OPC 
Server machine.  If the command 
is successful a list of the available 
OPC Servers is displayed in the 
Available Servers list box. If an 
Access is Denied error message 
is displayed it may mean that the 
DCOM Security settings are not 
properly setup on either the OPC 
Server or OPC Client machine. 
Refer to the appropriate section of 
this manual for more information 
on DCOM settings. 

 
To connect, double click on the 
Server name in the Available 
servers list box or select the 
Server name and click on OK. If 
no error messages are returned 
the connection is complete and the 
OPC group object was 
automatically created. 

 
Figure C-2 
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The next step is to define which of 
the OPC Items available in the 
OPC Server to add to the Client’s 
group. From the main menu select 
OPC->Add Item. (See Figure C-3) 

 
Figure C-3 

The Add Item dialog box is 
displayed with the defined devices, 
groups, and tags in the Browse 
items list box. (See Figure C-4) 

 
Figure C-4 



 

 

 

Select a device or folder in 
the Browse items list box 
and the associated tags 
are displayed in the right 
pane. To add a tag to the 
OPC Client group select 
the tag in the right pane 
then click on the Add Item 
button or double click the 
item. Click the Done 
button to save the OPC 
item to the Client’s group. 
(See Figure C-5) 

 
The OPC Client has 
subscribed to the tags 
displayed in the main 
window and the values will 
be automatically updated 
based on a change in data 
value. 

 
Figure C-5 

To read an OPC Item 
property, to force a read 
refresh , or to write an 
OPC Item supporting write 
access right click on the 
OPC item and select the 
appropriate command 
from the popup menu. 
(See Figure C-6) 

 
Figure C-6 
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If you are unable to establish a connection to Maxum OPC server or browse and add tags to OPC Client read 
through this section. Most problems connecting to OPC server relate to the DCOM settings on either the host or 
the client machine. 

 

Unable to Find a 
remote OPC Server 

First, check that you are able to communicate with the remote OPC Server machine 
from the client machine. Select Start->All Programs->Accessories->Command Prompt. 
At the command prompt type 'ping xxx.xxx.xxx.xxx'. Replace the xxx.xxx.xxx.xxx with 
the IP address of the remote machine. If the remote machine fails to respond to the 
ping there is a communication problem between the two machines. If the remote 
machine replies to the ping request then there is a problem with the OPC Foundation 
Core Components. Re-install or repair the OPC Foundation Core Components. 

"Class not 
registered" Error 

If you get this error while attempting to query Maxum OPC Server the OPC Foundation 
Core Components have not been installed correctly. Install the OPC Foundation Core 
Components. 

Unable to Query the 
Server 

If you are able to connect to Maxum OPC Server but the OPC Tags (Items) aren’t 
display the most common cause is incorrectly configured local DCOM security settings. 
Review the DCOM settings. 

Unable to Connect 
to Server 

If the OPC Client sees Maxum OPC Server yet it is unable to connect to it, the problem 
is most likely with your DCOM configuration. Review the Distributed COM section in 
this manual. 

Unable to Create a 
Group 

If you are able to connect to Maxum OPC Server but are unable to create a group, the 
problem is most likely with your local DCOM configuration. Review the Distributed COM 
section in this manual. 

Error While 
Querying Interface 

If you get this error while attempting to add a group to a connected client object, the 
local DCOM security settings are not permitting the OPC server to connect to the OPC 
client. 



 

 

Appendix D - Automation Client Example 
A working example of an Automation Client program is included with the Maxum OPC Server installation 
program. The Client program is written in Excel – VBA and can be used as a starting point in writing your own 
OPC Client application. The Excel Client program is located in: 

\Program Files\Siemens Industry\Client and is titled AutomationClientEx.xls. The program is an Excel macro 
and therefore requires that the Microsoft Excel program is loaded on your machine. 

Background: 

The OPC Data Access Automation Interface defines a standard by which automation applications can access 
process data. This interface provides the same functionality as the custom interface, but in an “automation 
friendly” manner.  The Automation Client can be written in Visual Basic or Visual Basic for Application (VBA). 
The Automation Client uses a ‘wrapper’ DLL provided by the OPC Foundation (OPCDAAuto.DLL) to 
communicate with the Custom interface provided by the Maxum OPC Server. The OPC Foundation specification 
for the Data Access Automation Interface Standard is included with the Maxum OPC Server installation and the 
OPCDAAuto.DLL was installed automatically with the OPC Server installation. The Automation Interface 
document defines the methods and parameters plus some examples to write an Automation Client. Use the 
example client program as is or as a guide in writing your own OPC Client. 

How to run the example Automation Client: 

First, execute the AutomationClientEx.xls program. This should start the Microsoft Excel program on you PC. 
The following dialog box will be displayed in Excel: (See Appendix C) 

Figure D-1 
 
 

Click on the Enable Macros button. 

The Advance Automation Client screen will be displayed similar to Figure D-2 
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Figure D-2 

 
 

Click on the CONNECT TO OPC SERVER button. The CONNECT to OPC Server Dialog box will be displayed. 
(See Figure D-3) Enter the IP address of the Maxum OPC Server then press the REFRESH NODE SERVER 
LIST button. The client program will use the OPC List Server located on the PC where the Maxum OPC Server 
is running to display a list of all the available OPC Servers in the SERVER LIST list box. Select 
Siemens.MaxumOPCServer.1 and click on the CONNECT TO SERVER button. 

Figure D-3 
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Then select the BROWSE OPC SERVER button (Figure D-2) to display a list of all the available OPC Items or 
Tags or Variables available at the OPC Server. (See Figure D-4) 

Figure D-4 

Select the OPC Items you wish to subscribe to from the Browse list box. If applicable use the scroll box to scroll 
down the available list. Double click on each item you want to subscribe to. 
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The selected items will appear in the spread sheet under the Tag Name column. (See Figure D-5) 

Figure D-5 
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Click on the SCAN OPC ITEMS button to subscribe and update the selected OPC Items values. (See Figure D- 
6) 

Figure D-6 

The selected items will be updated at the end of each analyzer cycle. 
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From the main menu select Tools->Macro->Visual Basic Editor to display the AutomationClientEx macro. 

Figure D-7 
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D-1. Client Code Descriptions 
Please refer to the OPC Foundation document titled “Data Access Automation Interface Standard”. This 
document was installed under the Maxum OPC Server directory. 

\Siemens Applied Automation\DOC\OPCDAAuto.doc or it can be obtained from the OPC Foundation web site 
at www.OPCFOUNDATION.org. The following example was written using VBA (Visual Basic Applications) 

 
 

Define the Server/Group/Item Objects 

First define the OPCServer Automation object, the OPCGroups and OPCGroup objects, and the OPCItems and 
OPCItem objects. The WithEvents syntax enables the object to support the declared events for the particular 
object. 

 
 

Public WithEvents OPCMyserver As OPCServer 

Public OPCMyBrowser As OPCBrowser 

Public WithEvents OPCMygroups As OPCGroups 

Public WithEvents OPCMygroup As OPCGroup 

Public OPCMyitems As OPCItems 

Public OPCMyitem As OPCItem 

Dim OPCItemIDs() As String 

Dim ItemServerHandles() As Long 

Dim Errors() As Long 

Public allCellsRange As Range 

Public IPAddress As String 

Public server As String 

 
 

Create The OPCserver Object 

Create a new OPCServer object and make a list of all the available OPC Servers located on the specified 
machine using the OPCServer object method GetOPCServers. 
(Sheet1.OPCMyserver.GetOPCServers(Sheet1.IPAddress)) 

 
 

Public Sub CommandButton1_Click() 

Dim servers() As String 

Set Sheet1.OPCMyserver = New OPCServer 

If UserForm1.TextBox1.value <> "" Then 

Sheet1.IPAddress = UserForm1.TextBox1.value 

Else 

Sheet1.IPAddress = "127.0.0.1" 

End If 

On Error GoTo ErrorHandler 

servers = Sheet1.OPCMyserver.GetOPCServers(Sheet1.IPAddress) 

UserForm1.ComboBox1.Clear 

Sheet1.ListBox1.Clear 
For I = 1 To UBound(servers) 

UserForm1.ComboBox1.AddItem servers(I) 

Next I 

UserForm1.ComboBox1.DropDown 

http://www.opcfoundation.org/
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UserForm1.ComboBox1.SelText = UserForm1.ComboBox1.List(0, 0) 

 
If UserForm1.ComboBox1.value <> "" Then 

Sheet1.server = UserForm1.ComboBox1.value 

End If 

 
Exit Sub 

ErrorHandler: 

MsgBox ("Can't connect to OPC Server, check IP address") 

End Sub 

 

Connect to the specified OPC Server and add a Group object. 

Using the server object (OPCMyserver) execute the connect method with input parameters server name 
(Sheet1.server) and server IP address (Sheet1.IPAddress) . Then Add an OPCGroup object (Group1) using the 
OPCGroups property of the server object. Create the Browser object using the CreateBrowser method of the 
server object. 

 
 

Public Sub CommandButton2_Click() 

If Sheet1.server = "" Then GoTo end1 

If Sheet1.IPAddress = "" Then GoTo end1 

Sheet1.OPCMyserver.connect Sheet1.server, Sheet1.IPAddress 

On Error GoTo ErrorHandler 
Set Sheet1.OPCMygroups = Sheet1.OPCMyserver.OPCGroups 

Set Sheet1.OPCMygroup = Sheet1.OPCMygroups.Add("Group1") 

Set Sheet1.OPCMyBrowser = Sheet1.OPCMyserver.CreateBrowser 

Sheet1.allCellsRange.Select 

Sheet1.allCellsRange.ClearContents 

 
UserForm1.Hide 

end1: 

Exit Sub 

 
ErrorHandler: 

MsgBox ("Access denied, check DCOM access settings on both server and client.") 

End Sub 

 

Create And Add Items To The OPCitems Object 

Using the OPCGroup object (OPCMyGroup) method OPCItems create the OPCItem object and add OPCItems 
to the group using the AddItems method. 

 
 

Public Sub OPC() 

On Error GoTo ErrorHandler 

Dim ClientHandles() As Long 

Dim AddItemCount As Long 

Dim BrowserCnt As Long 
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Dim txt As String 

Dim txt1 As String 

Dim branches() As String 

Dim path As String 

Dim device() As String 

Dim DevBranch As Integer 

Dim app() As String 

Dim strm() As String 

Dim comp() As String 

Dim branchCnt As Long 

Dim ret As Boolean 

 
If OPCMygroup.OPCItems.count > 0 Then 

OPCMygroup.IsActive = False 

OPCMygroup.IsSubscribed = False 

OPCMyitems.Remove OPCMygroup.OPCItems.count, ItemServerHandles, Errors 

End If 

 
ReDim ClientHandles(UBound(OPCItemIDs)) 

For X = 1 To CInt(UBound(OPCItemIDs)) 

ClientHandles(X) = X + 1 

Next X 

 
Set OPCMyitems = OPCMygroup.OPCItems 

OPCMyitems.AddItems UBound(OPCItemIDs), OPCItemIDs, ClientHandles, 
ItemServerHandles, Errors 

If Errors(1) <> 0 Then 

MsgBox "Error" 

End If 
 
 

Set The Group Active And Subscribe To The Group Data 

When the IsActive Groupproperty is set to TRUE , the OPC server reads out registered items. When the 
IsSubscribed property is set to TRUE, the DataChange event is called back on data change. The OPCItem 
object method READ is used to read the item values into the group variables. 

 
 

OPCMygroup.IsActive = True 

OPCMygroup.IsSubscribed = True 

 
Private Sub OPCMygroup_DataChange(ByVal TransactionID As Long, ByVal NumItems As 
Long, ClientHandles() As Long, ItemValues() As Variant, Qualities() As Long, 
TimeStamps() As Date) 

Dim anItem As OPCItem 

Dim row As Integer 

Dim col As Integer 

 
Worksheets("Sheet1").Activate 

For X = 1 To NumItems 
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Range("A9:E9").Select 

Range("A9").Activate 

Set anItem = OPCMyitems.Item(ClientHandles(X) - 1) 

anItem.Read OPCDevice 

row = ClientHandles(X) - 2 

col = 0 

ActiveCell.Offset(row, col).Activate 

ActiveCell.NumberFormat = "General" 

ActiveCell.value = anItem.ItemID 

ActiveCell.Offset(0, 1).Activate 

 
Select Case anItem.CanonicalDataType 

Case 3 

ActiveCell.NumberFormat = "General" 

Case 7 

ActiveCell.NumberFormat = "m/d/yy h:mm AM/PM" 

Case 8 

ActiveCell.NumberFormat = "General" 

ActiveCell.HorizontalAlignment = xlRight 

 
 

End Select 

 
ActiveCell.value = anItem.value 

ActiveCell.Offset(0, 1).Activate 

ActiveCell.NumberFormat = "m/d/yy h:mm AM/PM" 

ActiveCell.value = anItem.TimeStamp 

ActiveCell.Offset(0, 1).Activate 

ActiveCell.NumberFormat = "General" 

ActiveCell.value = anItem.Quality 

ActiveCell.Offset(0, 1).Activate 

ActiveCell.NumberFormat = "General" 

ActiveCell.value = anItem.CanonicalDataType 

Next X 

Range("A9").Activate 

End Sub 



Maxum OPC Server 
User Manual, 9/2014, v1.0a, 2000684-001 73 

 

 

Additional Information Resources 
1. The OPC Foundation web sites located at www.OPCfoundation.org or www.OPCeurope.org 
2. Book, OPC - Fundamentals, Implementation and Application, 2., published by Huthig Fachverlag 

ISBN-3-7785-2883-1, English, Amazon.com 
3. Book, “Inside COM”, Dale Rogerson / Microsoft Press, ISBN:1572313498, Amazon.com 
4. Web site, www.microsoft.com/com/wpaper/, site includes whitepapers on COM/DCOM 

http://www.opcfoundation.org/
http://www.opceurope.org/
http://www.microsoft.com/com/wpaper/


 

 

Glossary 
Client – 

In the Client / Server model the client is defined as a requestor of services. The Server is defined as a provider 
of services. 

 
COM – Component Object Model. 

COM is an "industry-standard" software architecture supported by Microsoft and many other companies. COM 
solves is the standard way for Windows program modules (applications) to communicate with each other. COM 
is a protocol that connects one software module (application) with another and then drops out of the picture. 

COM is a binary standard that specifies how objects interact with each other. A COM object is accessed 
exclusively through one or more sets of interfaces. An interface is a set of functions or methods. The COM 
standard not only specifies the binary object standard, it also defines a series of standard interfaces that provide 
common functionality. The OPC-DA specification defines several COM objects and their associated interfaces. 
These objects and interfaces provide a standard for real-time information exchange between software 
applications and process hardware. 

The Maxum OPC Server uses Microsoft COM/DCOM/OLE technology to communicate with clients. 
 

Component – 
Typically a component is defined as an analysis peak result. For Maxum and Advance Optichrom analyzers 
analysis peak values are stored in the Result table. Every Component or Result has certain attributes 
associated with the Result value. For the OPC Server every Component must have a name, value and trtval 
defined. The trtval attribute determines if the result is visible to the OPC Server and defines the result’s 
reference number. 
NOTE: Any database variable can be placed in the Result table and assigned a name and trtval. 

 
DCOM – The Distributed Component Object Model 

DCOM extends COM to networks (remote objects). It is a new, highly optimized protocol, where remote 
components appear to be local. 

 
Domain – 

In Windows NT/2000/XP network security terms, a Domain is a group of machines that have reason to work 
together. Examples include Sales domain, Engineering domain, Account domain. Typically a Domain Server is 
setup that provides name and password authentication for the Users and Groups in the Domain list. Multiple 
domains may or may not be able to access one another unless a special relationship called a Domain Trust 
Relationship has been setup. A Domain user consists of the Domain name + user name. 

 
Domain User/Groups – 

In Windows NT/2000/XP network security terms, a Domain User or Group account can be used on any computer 
that is a member of the Domain. Authentication of the user name plus password is handled by the Primary 
Domain controller. It’s easier to setup the DCOM permissions on both the OPC Server and Client with a Domain 
account as opposed to a Local User/Group account. 

 
Group(s) – 

In Windows NT/2000/XP security terms, a Group contains one to many Users A Group account is easier to 
maintain when user names or access permissions will change frequently. Its easier to add/delete Users from a 
Group when granting temporary access for maintenance reasons. Proper use of Groups is a good way to 
reduce long-term maintenance costs. 

 
Local User/Groups – 

In Windows NT/2000/XP network security terms, a Local User or Group account is known only to the machine 
the account is setup on. Local accounts cannot access another machine unless the identical Local account 
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(username plus password) was setup on both machines. Its typically easier to setup and use a Domain account 
with OPC Server and remote Clients. 

 
OPC – OPC (OLE for Process Control) 

OPC is based on Microsoft’s OLE, COM (component object model) and DCOM (distributed component object 
model) technologies, OPC consists of a standard set of interfaces, properties, and methods for use in process- 
control and manufacturing-automation. 

OPC is an industry standard created by the OPC Foundation in collaboration with Microsoft corporation. The 
OPC Foundation is an organization with over 300 members world-wide consisting of nearly all the major control 
systems, instrumentation, and process control systems providers. 

The objective of the OPC Foundation is to develop an open, flexible, plug-and-play standard that allows 
instrumentation suppliers to develop standard form device drivers that "serve" the data to any application 
supporting an OPC client interface. 

 
Query – 

A query is a request for information from a database. In the Client / Server model the client is the requestor and 
the server responds with the information from the database. A database query can be fixed or active. A fixed 
query is evaluated exactly once and the resulting data is sent back to the client. An Active query is a procedure 
established on a set of data where subsequent changes in the data result in updates being sent to the requestor 
until the query is closed or shutdown. 

 
Server – 

In the Client / Server model the Server is defined as a provider of services. The Client is defined as a requestor 
of services. 

 
User(s) – 

In Windows security terms, a User is a login name + password combination used to gain access (sign on) to the 
Windows machine. 
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